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 ArcFM™ Overview 
   
 ArcFM is a powerful extension of ESRI's ArcGIS® 9 platform that 

provides a complete enterprise utility solution for editing, 
modeling, maintenance, and management of facility information 
for electric, gas, and water/wastewater utilities. ArcFM takes 
advantage of an industry-standard architecture and programming 
environments, an easy-to-use interface, and powerful cartographic 
tools, giving utilities an optimized solution for the entire 
organization.  

 ArcFM consists of a family of models and a set of sophisticated 
tools that provide a comprehensive application for energy and 
water/wastewater utilities. ArcFM allows maintenance and viewing 
of data, using company specific business rules, and includes 
applications to configure the data models and tools to work 
together.  

 ArcFM supports the vertically integrated enterprise, making it easy 
to view, edit, map, and manage spatial data in a multi-utility 
context. ArcFM fits into the overall information technology through 
the use of open databases, industry-standard programming 
environments, and Component Object Model (COM) architecture. 

Open Architecture, Open Database, Open Development Tools 

 ArcFM is implemented within the ArcInfo environment using an 
object-oriented architecture. The supported hardware platforms 
are Windows 2000 and Windows XP. ArcFM was developed using 
VB6, C++, and C# and these languages can also be used for 
customization and extension of the application. 

 ArcFM is an extension of ArcGIS, which relies on the effective use 
of components. ArcEditor, ESRI’s professional GIS, sets the 
standard for applying geographic requirements and supporting 
spatial decision-making. From project GIS to a large spatial 
enterprise, ArcEditor is the scalable solution that provides a 
complete, integrated platform for creating, managing, and 
disseminating geographic information. 

ArcFM/ArcMap Menu Interface 

 The ArcFM toolbar is the interface to most of the geo-processing 
and analysis components. ArcMap is the user interface for the 
query/display/edit environment, and is the foundation for ArcFM. 
Its foundation is the data management system of ArcSDE, which 
implies an RDBMS used as a data repository. 
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Figure 1: ArcMap and the ArcFM Toolbars  

ArcMap Menu The ArcMap Main Menu accesses the application’s primary 
operations. The menu bar is identical in behavior to Microsoft 
Windows menu bars.  Access keys are present for all menu bar 
items. This means, for example, that pressing Alt+F opens the File 
drop-down menu. 

 Clicking a menu bar item, such as File, Edit or View, displays drop-
down menus that list tools associated with the menu topic. For 
example, the File menu contains options used to Open, Save, and 
Close a map document, as well as to exit the application.    

ArcFM Toolbars When selected, toolbars appear by default beneath the menu bar. 
To display a toolbar, right-click in the gray area and check or 
uncheck the desired toolbar. Toolbars are dockable. There is a 
single main interface containing tools applicable at all points in the 
application, and several additional toolbars with special-purpose 
tools. 

 ArcFM presents toolbars when their use is appropriate given the 
application context. For example, the editing toolbar will normally 
be inactive when no layer in the map document can be edited. 
Users can right-click in the menu bar, or on any toolbar, to display 
a pop-up menu for selecting any toolbar available. When tools are 
not valid, the individual tools will be disabled (grayed-out). 

Arc Geodatabase  

 The following describes some of the key features of ArcInfo 
functionality within the ArcFM solution. For a more complete 
functional description, please refer to the ArcGIS and ArcFM online 
help and user guides. 

Data Validation A geodatabase supports three broad types of validation rules: 
attribute validation rules, network connectivity rules, and 
relationship rules. Both the ArcMap Editor and the ArcFM QA/QC 
tools help users identify invalid features. 
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 Editing geometric network feature classes is one of the most tightly 

integrated geodatabase editing tasks. When a user creates new 
network features, topology is maintained on-the-fly, and is 
continuously updated as the user modifies network features. 

 When snapping network edges together, the editor uses the 
connectivity rules the administrator has defined for the network to 
determine the correct junction type for connecting the two edge 
features. When users adds junctions or connects edges to complex 
edges, the geometric network is automatically updated. 

 Using the editor with the network analyst tools in ArcMap helps 
maintain correct connectivity while geometric network features are 
being edited.  

 Types of data validation include: 

 Domain values – range and domain values for attributes 

Default values – predefined default values for attributes 

Connectivity rules – rules to ensure valid feature 
connectivity 

Split/Merge rules – rules to ensure valid features may be 
split or merged 

Network properties – definition of what features are within 
an electric network or gas distribution and therefore may 
be traceable 

Relationship – for example, high voltage lines can connect 
to low voltage lines through a transformer, or different 
pressure systems can be joined through a regulator station 

Custom – developers implement in ObjectClassExtension 

Electric, Gas and Water Object Models  

 ArcFM provides gas, water, waste water, and several electric 
enterprise object models from Miner & Miner, a Telvent company  
These formal models, specified using Unified Modeling Language 
(UML), represents electric, gas, or water distribution facility 
features. Included within the model is a complete specification of 
all custom features, relationships, validation rules, domain 
specifications, default values, and subtypes. Additionally, users can 
build an instance of the model within a geodatabase using the 
ArcInfo CASE tool wizard.  M&M also supplies a Multispeak-
compliant model for the REA/Coop market. 

Versioning ArcFM’s versioning capability allows single or multiple users to edit 
a database concurrently. Many users may never realize they are 
working with a version. A typical work session involves a user 
connecting to a version of the database, performing edits, saving 
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those edits, and performing more edits, if necessary. 

 Versioning allows multiple users to view and edit the same version 
at the same time. Each version has a unique name, but all versions 
have the same schema. This permits a user to have several pending 
projects for the same area or facilities. Creating versions of versions 
is also supported. 

 Versions can be used to create “what if” scenarios for 
systems/operations planning. These versions would not typically be 
posted to the master database and used only for 
evaluation/analysis purposes. 

 ArcFM Features 

 Attribute Editor 

Displays Attributes The ArcFM Attribute Editor is the key to editing and placing 
features on the map. The Targets tab displays the attributes of 
feature classes to be placed on the map, and the Selection tab 
displays existing features selected for editing. When a feature is 
selected, a right-click context menu provides options including 
highlighting and zooming to existing features as well as creating 
related features and objects.  

 

Figure 2: Selection Tab

 
Performs Validation The QA/QC tool utilizes basic database validation principles such as 

relationship and connectivity rules to validate attribute values. 
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ArcFM users may also define custom validation rules 
programmatically and enable those rules in ArcCatalog using the 
ArcFM Properties Manager. 

 The QA/QC tool may be accessed on the ArcFM toolbar, or from 
the right-click Utility menus in the Locator tool and on the QA/QC 
tab or Selection tab of the Attribute Editor. The QA/QC tab displays 
messages that provide the user with information necessary to 
correct domain, relationship, or connectivity errors. 

  

   

 Figure 3: QA/QC Error Message

 The QA/QC tool is linked with the Locator tool so users can quickly 
navigate to features based on an attribute value, feeder ID, or 
position on the map. Users can also display read-only screens based 
on Feeder Manager, underground conduit configuration, or 
attribute information. 

  The ArcFM's QA/QC tool can be used to validate selected features 
and generate a report or export the results to an XML file.   

 The QA/QC Version Difference tool allows users to compare the 
current version with the parent version using the QA/QC Validation 
rules to validate modifications. 

Customizable Display The editor grid can be customized to serve specific business 
processes.  An administrator can change the order of attribute 
fields in the editor display as well as change the editability and 
visibility of a field (except the ObjectID field).  

Automated Behavior ArcFM autoupdaters automatically generate an attribute value at 
the onset of a specific event such as adding or deleting a feature. 
An example is the ArcFM Structure Relate autoupdater, which 
searches for an existing structure in the area around a new device. 
If one is found within its search tolerance (the default is 25 map 
units), it automatically relates the new device to the structure. 
Autoupdater objects can also: 

 • Split a line when junction is placed. 
• Rotate a point feature to align with conductor or pipe 

features. 
• Find features using a field defined as the ArcFM Display 

field. 
• Find all tie devices (open, switchable devices) associated 

with a selected feeder system. 
• Find features by value defined in any field for a given 

feature class. 
• Update and display conductor and conduit annotation. 
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Mass Attribute 
Update 

 

Modify Groups of 
Features 

The Mass Attribute Update tool allows users to quickly and easily 
make modifications to a large group of features and update 
attribute fields for features that have the same subtype. For 
example, a group of non-wood poles can be changed to 45-foot 
steel poles in just a few clicks. 

 
Phase Swap Tool 

 

Swap Phase 
Designation 

The Phase Swap tool gives users the ability to switch a branch of 
existing energized feeder from one phase to another. 

 
Features Tab Tree  

Favorites Overview When users begin an edit session, the Features tab in the ArcMap 
Table of Contents is populated with available features and related 
objects. Features selected on this tab have default attribute values 
and appear on the Targets tab of the Attribute Editor ready to be 
edited and placed on the map. Cursor symbolization is also 
included.  To save time, users and administrators can pre-set 
feature attribute values (and those of related features and objects) 
by creating user or system favorites. Users can also create 
composite favorites, which include multiple features to be placed 
on the map as a single item. For example, a service line composite 
favorite could include the fitting, service line, and meter setting.  
This saves users additional editing time.   



ArcFM 

 

 Figure 4: ArcFM Features Tab

 Drag and drop functionality makes it easy to create favorites with a 
feature or its subtypes. Just click a feature class node to display 
subtypes. Clicking the node again hides the list. 

 

Session Manager  

Follow a Workflow 
Specific to Your 
Business 

Session Manager gives users the power to establish and enforce 
particular version workflows and user roles tailored to their own 
business needs. Using Session Manager, a user may create a 
session, which travels through an approval process before 
ultimately being posted to the geodatabase or deleted from the 
system. 
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 Figure 5: Session Manager 

Process Framework Administration Tool  

Create and Manage 
Your Workflow 

The Process Framework Administration Tool allows an 
administrator to create new workflows for use in Session Manager 
(in ArcFM), and Workflow Manager (in Designer). The Process 
Framework Administration Tool can be used to add/remove users 
and change role permissions. 

• Subtasks allow users to create customized tasks that may 
be used in Session Manager and Workflow Manager as 
well as custom Process Framework extensions.  

Process Framework 
Database Upgrade 
Tool 

The Process Framework Database Upgrade tool will update the 
database with enhancements available in the latest version. 
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QA/QC Tool  

 

 Figure 6: QA/QC Options

Validate Features and 
Attributes 

The ArcFM QA/QC (Quality Assurance/Quality Control) tool ensures 
database integrity and validates features based on coded domain 
values, range domain values, connectivity rules, relationship rules, 
contingent validity rules, and the user’s custom validation rules. 
Clicking the QA/QC tool on the ArcFM toolbar starts the process of 
verifying the validity of the selected set of features. Results and 
messages display on the QA/QC tab. Messages displayed with 
invalid features provide information to correct errors. 

QA/QC Reporting  

 After running the ArcFM QA/QC tool, users have several choices 
for saving or printing the results:  

 Report: Users can create and print a report listing selected features 
with a valid/invalid message; they can choose from default styles or 
create their own. 

 Write to file: save information to track invalid data in a database. 
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 Read from file: retrieve information a user saved using Write to 
file. 

 QA/QC Tool Options: choose between listing all features after 
running QA/QC and listing only invalid features for saving or 
reporting. 

Query and Locator Tool 

Navigate Quickly to 
Specified Features 

ArcMap and ArcFM provide several ways to explore data and 
retrieve specific information. Users can hover on features with 
ArcMap’s Identify tool to display a read-only attribute list. The Find 
tool lets users locate features in a selected layer containing a 
specific text string. The Measure tool lets users easily measure 
distances on the map. Map tips provide a quick way to browse 
map features. Like Tool Tips for toolbar buttons, map tips pop up 
while hovering the mouse pointer over a feature.    

 ArcFM query tools include the Locator, with several strategies for 
finding features including the Attribute Query, Feeder ID, and XY 
coordinates pointer to locate features within a user-defined search 
distance. Once the results of a search are compiled, users can 
utilize right-click tools to highlight, pan to features, zoom to 
features on the map, or add features to the selected set. 

Routing and Direction Tools 

 These tools provide methods for locating and navigating to specific 
addresses on a map.  All require the existence of an associated 
locator (.loc).  Instructions for creating address locators using 
ArcCatalog are available in the ArcGIS Desktop Help. 

Address Search Marks the location on the map and zooms the display to it. 
Requires input of an address or intersection. 

Direction Search Uses two addresses to create driving directions and a route map. 

Page Templates  

Store Standard Map 
Elements 

Page Templates lets users define and store standard map page 
elements to the ArcMap layout view. A page template defines the 
size, orientation, and map elements that are stored in the database 
for easy access. Page templates save time and standardize map 
documents by standardizing elements used on every map. A user 
can then select a page template for their layout without 
closing/opening a new document.   

Stored Displays  
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Set Map Views Stored Displays allow users to change a large number of 
parameters in one step, for switching back and forth among 
different views. This tool allows users to set map views including 
standard symbology. These settings are saved in the database and 
retrieved when users log in. 

ArcFM Data Source 
Wizard 

The ArcFM Data Source Wizard allows users to change data 
sources for the layers in stored displays, documents, and designs 
(only in Designer).  This is especially useful when moving stored 
displays from one server to another. 

Documents  

Store Multiple Maps 
and Data Frames 

Documents combine Stored Displays and Page Templates so users 
can store multiple maps and multiple data frames. Stored Displays 
save multiple layers of a map while Page Templates define and 
store standard plotting page elements such as size, orientation, 
and graphic elements. 

 
 When switching between map documents, the data frame and 

layer properties such as borders, background colors, annotation 
styles, symbology, map elements, page dimensions, and page 
orientation are easily changed in one step. 

Map Production  

Schedule Map Printing Map Production allows users to select the page templates, stored 
displays, documents, and map sets that precisely define layers, 
scale, and map elements. Users can then select polygons (map 
grids, for example) and create map sets to be stored for easy 
retrieval and printing. Maps can be previewed in final format 
before printing. For convenience, plotting can be scheduled at a 
time that puts less demand on resources. Enhancements have been 
made to Map Production that provide a fully exposed API 
(application programming interface) which allows for greater 
flexibility in developing automated mapping and plotting solutions. 
In addition, users have the ability to organize map sets into map 
books.  
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 Figure 7: ArcFM Map Production Tool

Map Grid Generator  

Define Custom Map 
Grids 

Map Grid Generator allows users to generate customized map 
grids for use with Map Production. You may determine the area 
covered by the map grid as well as the size, orientation, and scale 
of the map sheets that compose the grid. 

  

Map Insets  

Enlarge a Specific 
Portion of the Map 

Map Insets allows users to identify a specific portion of the map as 
a source, then enlarges the source in a destination window on the 
map.  Users may also link external files to appear in the destination 
window. A Map Inset is an ArcFM feature, which is placed on the 
map and is visible within the map data frame in the Layout view. 

Autotext Elements  

Insert Text to Update 
Automatically 

The Autotext Elements functionality provides a framework to easily 
create sources of updateable text (such as date, user name, and 
page number) without implementing a new custom page element 
every time. A user can place Autotext Elements in the Layout view 
and use Map Production to print maps containing text, which 
updates dynamically. 

Abandon Tools  
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Define Features to be 
Abandoned and 
Removed 

The Abandon Tool represents the process of abandoning pipes (or 
other features), removing them from the network, and converting 
them to conduit. Administrators configure the Abandon Tool in 
ArcCatalog using the ArcFM Properties Manager to define which 
features can be abandoned, whether they remain on the map, and 
whether they can be converted to conduit. Features are then 
displayed in the Abandon Tool Options dialog in ArcMap. For 
example, distribution mains can be deleted from the current 
feature class and moved to a new "Abandoned Pipe" feature class, 
or distribution mains could be abandoned to a new subtype and 
symbology. Features can also be removed entirely or converted to 
conduit for later use.   

 Figure 8: Abandon Tool Options

Inset Frames  

Highlight Specific 
Features 

The Inset Frames tool allows users to pull specific features from the 
current view and display them individually in separate windows in 
the Layout view. For example, a user can depict each Switching 
Facility in her current view in its own inset frame at a smaller scale. 

Favorites  

Predefine Attribute 
Values 

The Favorites feature provides an efficient way to manage and edit 
often-used features. The administrator can set system-wide 
favorites in ArcCatalog, and users can view system-wide favorites 
categories in ArcFM. Users can also create their own favorites 
categories from the Features tab in ArcFM. As users add categories, 
the Features tab is dynamically updated. 
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 Figure 9: ArcFM’s Create Favorite Dialog

Composite Features  

Place Composite 
Features with One 
Click 

Composite Features help users add sets of features more 
productively. In the electric domain, users can place switchgear 
cabinets or substations that contain internal busbars, switches, and 
fuses. ArcFM allows users to set the attributes for each feature and 
then place the composite on the map with one click. 

Create Template A template is composed of sketch points with spans between them 
to which point and line features can be associated. During this 
process,a user can define the offset and rotation of the features. 
The ArcFM Template Favorite Tool allows the user design template 
favorites with choice lists that prompt the user to make a selection 
during placement. Facilities are automatically placed as defined in 
the template. 
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 Figure 10: The ArcFM Template Tool Choice List 

Graphics and Digital 
Ink 

 

Graphics Tab The graphics tab allows users to place graphics in the map without 
impacting the geometric network.  This tab may be used with 
ArcFM Mobile or ArcFM Viewer with the Redliner extension to 
provide redlining capabilities in the field.  Users may create 
customized graphic and text favorites and place them on the map 
using the Graphics tab.  ArcFM also supports the use of Digital Ink 
to support redlining. 

Network Tracing  

Trace Network 
Connectivity 

ArcFM provides four different tracing toolbars to meet each utility’s 
business needs. The ArcFM Electric Traces toolbar allows electric 
utilities to easily perform upstream and downstream distribution 
traces. Separate toolbars are available for gas and water tracing. 
These trace tasks allow utilities to trace how natural gas or water is 
flowing through a network of connected features. If a utility has an 
underground network, the Conduit Manager Trace toolbar allows 
users to perform duct availability tracing. All trace results (electric, 
conduit, gas, water) may be displayed with a buffer,  Buffer size 
can be easily determined using the Buffer Distance Tool. 

Electric Trace Tasks  

 Upstream Protective Device – traces from a user-specified point 
upstream to user-specified protective devices. 
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 Downstream Protective Device – traces from a user-specified point 
downstream to user-specified protective devices. 

 Electric Distribution – traces electric distribution equipment and 
feeders by phase. 

 Downstream Trace – traces all devices in a feeder system, by phase 
that are downstream from the trace flag. 

 Upstream Trace – traces all devices in a feeder system, by phase 
that are upstream from the trace flag. 

Gas Trace Tasks  

 Gas Distribution System – encompasses all the pipes and devices 
that can be reached from a town border or regulator station.  

 Gas Pressure System – traces gas pipes and devices within a specific 
pressure system. 

 Gas Cathodic Protection System  – identifies sections of a gas 
distribution system that utilize cathodic protection devices. 

 Gas Valve Isolation – identifies valves or other devices that need to 
be shut off to isolate a specific area. Users are allowed to include 
or exclude specific valves from the trace as necessary and place 
temporary sources and interruptions. 

 Gas Squeeze-Off – determines whether pinching the pipes at a 
selected location will disrupt the flow of gas to a specific area. 

Water Trace Tasks  

 ArcFM supports a variety of trace tasks for water distribution 
networks. Water trace tasks allow users to check how water is 
flowing through a network of connected features: 

 Water Distribution System – encompasses all the pipes and devices 
that can be reached from a tank or a pumping station.  

 Water Pressure System – traces water pipes and devices within a 
specific pressure system. 

 Water Cathodic Protection System – identifies sections of a water 
distribution system that utilize cathodic protection devices. 

 Water Valve Isolation  – identifies valves or other devices that need 
to be shut off to isolate a specific area.  Users are allowed to 
include or exclude specific valves from the trace as necessary and 
place temporary sources and interruptions. 
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 Water Squeeze-Off – determines whether pinching the pipes at a 
selected location will disrupt the flow of water to a specific area. 

Feeder Manager  

Automatically Update 
Energized Phase 
Information 

With ArcFM Feeder Manager, users can easily manage complex 
feeder systems, generate a circuit map, locate all features or tie 
devices associated with a feeder, select features belonging to a 
particular feeder or group, and show feeder information 
graphically in a map display (loops, islands, and double feeds or 
extra feeds). The Feeder Manager tool writes Feeder ID and 
energized phase information to the ArcFM database in attribute 
fields of individual electrical features. It also assigns energized 
phase information to each feature in a circuit, indicating by name 
(A, B, or C) the phases of electric power that can reach the feature 
from the power source(s) for the circuit. Once assigned to ArcFM 
features, Feeder Manager uses autoupdaters to update information 
about circuit association or energized phases. 
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 ArcFM Extensions to 
ArcCatalog 

ArcFM Properties 
Manager 

The Properties Manager in ArcCatalog is the key to configuring 
ArcFM functionality such as Feeder Manager and the Abandon 
tools. Model names and autoupdaters are assigned to perform 
crucial editing tasks at the onset of specific events. An example is 
splitting a complex edge when a device feature is connected to it 
or assigning the phase to automatically correspond to the 
conductor on which it is placed. Model names identify features and 
fields independently of database names. 

 

 Figure 11: ArcFM Properties Manager
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 Administrators also use the Properties Manager to reorganize the 

appearance and behavior of feature attribute fields. Users can 
change, at the feature class or subtype level, whether an attribute 
field is visible or editable, and what order it appears on the 
Attribute Editor.  

Properties Manager 
for Relationships 

ArcFM lets users assign autoupdaters to relationship classes. The 
sample autoupdater included with ArcFM automatically adjusts the 
rated kVA of the transformer bank when a transformer unit is 
added or deleted. 

Figure 12: Properties Manager for Relationship Classes

Feature 
Autoupdaters 

Administrators use the ArcFM Properties Manager to set specific 
behaviors (enabled by COM autoupdater objects) at certain events 
such as when a feature is added, updated, or deleted. This dialog 
also makes it easy to assign multiple autoupdater objects to a 
single event, reducing the need to programmatically create combo 
autoupdaters.  

Field Autoupdaters Similar to feature autoupdaters, administrators can set rules to fire 
when a single field is updated. One example is setting the angle of 
a point feature based upon the line it is snapped to. Field 
autoupdaters also maintain metadata such as recording the last 
user and the date a field was edited.   

Field Display Administrators can define the order in which fields are displayed on 
the Attribute Editor providing the opportunity to put the most 
important fields at the top of the grid where they can be seen 
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easily. 

Custom Field Editors Custom Field Editors provide the implementation/customization 
programmers with the ability to create specialized field editors that 
are specific to their needs. The ArcFM installation provides default 
field editors. 

Custom Validation 
Rules 

Custom validation rules offer users the ability to define a set of 
rules for determining the validity of any object in a geodatabase. 
These rules help users to build a database that conforms to their 
specific business domain and maintains data integrity.   

ArcFM Solution 
Toolbar 

The ArcFM Solution toolbar provides quick and easy access to some 
powerful ArcFM tools such as the Snapping Manager and 
Geodatabase Extraction. 

Context sensitive help is available for all buttons on the ArcFM 
Solution toolbar. 

 

Figure 13: ArcFM Solution Toolbar

Snapping Manager Snap means that as a user places a feature, it connects to the 
target when it is within a certain distance, referred to as the 
snapping tolerance. The ArcFM Snapping Manager lets the user set 
up the snapping environment for a given workspace. The snapping 
environment in ArcMap is dynamically updated based on the 
currently edited feature class. Administrators can set and store the 
required snapping for network (and non-network) features. This 
relieves the user from changing the snapping environment as each 
new feature is added. 

System Favorites ArcFM System Favorites lets users group and define the attribute 
values of frequently used features. Administrators create favorites 
that are used but not edited by users. Users can then place the 
feature on the map using the Attribute Editor Targets tab. Users 
cannot edit the attribute values defined for system favorites. 

Geodatabase 
Extraction Utility 

Re-architectured to increase performance, this tool provides a way 
to transfer user-defined features and object classes from an 
existing enterprise or personal geodatabase to a new personal 
geodatabase. The user identifies the template, which is the empty 
personal database that will contain extracted feature and object 
classes (a sample is included with Minerville); a destination for the 
new personal geodatabase; and values that define the polygon 
area for extraction. The tool also allows the optional extraction of 
the geometric network from the geodatabase. 

XML Import/Export The ArcFM XML Import/Export utility lets users transfer information 
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Tools such as model names, snapping, properties, geometric network 
definitions, and domains between geodatabases. The export tool 
allows users to export an entire geodatabase, dataset, or individual 
feature class. The import tool will import a database, dataset, or 
feature into a selected geodatabase. Both tools are on the ArcFM 
Solution toolbar, which can be found in ArcCatalog.  

Create ArcFM 
System Tables 

The administrator uses this tool once to generate tables required by 
ArcFM (and, if licensed, Designer) software to support Page 
Templates, Stored Displays, Documents, Favorites, and Snapping 
information. 

ArcFM Object 
Converter 

Use this tool to convert tables, feature classes, feature datasets, or 
geodatabases to ArcFM or ESRI objects in ArcCatalog. If users add 
new features or objects to the geodatabase, administrators will run 
the Object Converter tool to enable the autoupdaters for new 
features. 

Upgrade ArcFM 
Solution Database  

This tool gives users a simple method for making modifications 
required by the latest release of the ArcFM Solution.  

Clean Up Orphaned 
Versions 

This tool allows users to delete orphaned version data. Version 
information may be left when a node is deleted in a Process 
Framework extension, but a connection is not available to delete 
the corresponding data in ArcMap. This remaining information is 
marked as orphaned until this tool is used to delete it.  

  
 

 ArcFM Documentation 

Upon the purchase of the software, Miner & Miner provides a large variety of manuals. The 
following documentation of ArcFM is available at no additional charge: 

Minerville is a personal geodatabase (MS-Access) that is provided 
with sample data for electric and gas distribution and landbase. 
This data is based on the ArcGIS Energy models. 

Physical Sample 
Database 

ArcFM Logical Data 
Model 

Visio diagrams for Miner & Miner’s data models are provided as 
graphical representations of standard ArcFM geodatabases. 

 Note – These are non-specific (or untailored) models. They are 
often a starting place for a gap analysis with users when beginning 
an implementation. 

ArcFM Physical Data 
Model 

Visio diagrams for gas or electric distribution and electric 
transmission data models from Miner & Miner, or water data 
model from ESRI, used to create geodatabase schema using 
ArcCatalog CASE Tools. 

ArcFM Object Model Visio diagram that graphically represents the structure of the COM 
architecture of ArcFM. 

Process Framework Visio diagram that graphically represents the structure of the COM 

Miner & Miner, a Telvent company White Paper 23 



ArcFM 

 

April 2006 24 
 

Object Model architecture of Process Framework. 

ArcGIS Data Models 
(PDF format) 

Printable documents that provide in depth information about the 
attributes in the ArcFM Data Model for implementation. 
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Gas Distribution - 
ArcGIS Data Models 
(PDF format) 

Printable documents that provide in depth information about the 
attributes in the ArcFM Data Model for the Gas implementation. 

Water Distribution - 
ArcGIS Data Models 
(PDF format) 

Printable documents that provide in depth information about the 
attributes in the ArcFM Data Model for the Water implementation. 

Waste Water 
Distribution - ArcGIS 
Data Models (PDF 
format) 

Printable documents that provide in depth information about the 
attributes in the ArcFM Data Model for the Wastewater 
implementation. 

Electric Transmission- 
ArcGIS Data Models 
(PDF format) 

Printable documents that provide in depth information about the 
attributes in the ArcFM Data Model for the Electric Transmission 
implementation. 

Using ArcFM Solution 
Online Help 

The ArcFM online help provided in the Help menu of ArcMap 
offers procedures for performing various editing tasks with ArcFM 
functionality. Available in the Help menu of ArcMap, in the ArcFM 
Solution folder on the Start Menu, and in Miner and Miner\ArcFM 
Solution\Documentation\Help\UsingArcFMSolution.chm. 

Session Manager 
Online Help 

The online help provided in the Help menu of Session Manager 
offers procedures for performing various tasks in Session Manager. 
Available in the Help menu of Session Manager. This online help 
file is also integrated with the Using ArcFM Solution online 
documentation available in the ArcMap Help menu. 

Process Framework 
Administration Tool 
Online Help 

The online help provided in the Help menu of the Process 
Framework Administration tool offers procedures for performing 
various tasks in the Process Framework Admin tool. Available in the 
Process Framework Administration Tool Help menu. This online 
help has also been integrated with the Using ArcFM Solution online 
documentation available in the ArcMap Help menu. This file is only 
installed with the Administrator version of ArcFM. 

Configuring ArcFM 
Solution Online Help 

The ArcFM online help provided in the Help menu of ArcCatalog 
offers procedures for configuring ArcFM tools for use in ArcMap. 
Available in the Help menu of ArcCatalog, in the ArcFM Solution 
folder on the Start Menu, and in Miner and Miner\ArcFM 
Solution\Documentation\Help\ConfiguringArcFMSolution.chm. This 
file is only installed with the Administrator version of ArcFM. 

Set Up Process 
Framework Online 
Help 

This online help file offers procedures for configuring Session 
Manager and Workflow Manager (in Designer only) for use on 
Oracle and SQL servers. It has been integrated with the 
Configuring ArcFM Solution online documentation available in the 
ArcCatalog Help menu and in the ArcFM Solution folder on the 
Start Menu. This file is only installed with the Administrator version 
of ArcFM. 
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ArcFM Solution 
Developer Online Help 

This online help file provides information about how to customize 
your ArcFM Solution and the components necessary. It is available 
in the ArcFM Solution folder on the Start Manu and in Miner and 
Miner\ArcFM Solution\Developer 
Resources\ArcFMSolutionDeveloperHelp.chm. 

ArcFM Solution 
Component Online 
Help 

This online help file provides information on the classes, interfaces, 
and enumerations that developers may utilize to customize the 
ArcFM Solution. The help file has been integrated with the ArcFM 
Solution Developer Online Help available in the ArcFM Solution 
folder on the Start Menu. 
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Customize ArcFM 
Online Help 

This online help file discusses customizing specific ArcFM tools and 
offers code samples to support these discussions. The help file has 
been integrated with the ArcFM Solution Developer Online Help 
available in the ArcFM Solution folder on the Start Menu. 

Customize Process 
Framework Online 
Help 

This online help file describes how to create custom Process 
Framework tools and offers code samples. The help file has been 
integrated with the ArcFM Solution Developer Online Help 
available in the ArcFM Solution folder on the Start Menu. 

Customize Session 
Manager Online Help 

This online help file offers details about how to customize Session 
Manager. The help file has been integrated with the ArcFM 
Solution Developer Online Help available in the ArcFM Solution 
folder on the Start Menu. 

Project Samples Online 
Help 

This online help file describes the Developer Samples and Shared 
Product Code provided with the ArcFM install. The help file has 
been integrated with the ArcFM Solution Developer Online Help 
available in the ArcFM Solution folder on the Start Menu. 
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Miner & Miner, a Telvent company, is a world leader in the development and implementation of 
geographic information system (GIS) software for utilities. M&M’s ArcFM Solution and extended 
services assist electric, gas, water, and waste water utilities in increasing productivity, lowering costs, 
and improving services by allowing them to effectively manage spatial information.  

Founded in 1946 as a full-service electrical engineering firm, M&M has been an equity partner of 
ESRI since 1987. This partnership has enabled M&M to become the world’s leading developer of 
ArcGIS applications for the utility industry. M&M services include implementation, integration, and 
customization of software to fit the needs of individual utilities. 

 

Corporate 
Miner & Miner 

4701 Royal Vista Circle 

Fort Collins, Colorado 

80528, USA 

Telephone: 970.223.1888 

Fax: 970.223.5577 

 

For more information on 
Miner & Miner call 

1-970-223-1888 
 

Send e-mail inquiries to 

info@miner.com
 

Visit M&M’s Web site at 

www.telvent.com/miner/ 
 
 

Regional Offices 
 
 Athens, Georgia Philadelphia, Pennsylvania 
 1 Huntington Road 1400 Morris Drive, Suite # 102 
 Athens, GA  30622 Chesterbrook, PA  19087 
 (706) 353-0797 (610) 491-9567 
 Contact: Scott Higgins  Contact: Andy Bennett 
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